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BAB III 

METODE PENELITIAN 

 

A. Rancangan Penelitian 

Rancangan penelitian ini akan  membahas tentang pendekatan 

penelitian dan  jenis penelitian. 

1. Pendekatan Penelitian  

Penelitian ini menggunakan pendekatan penelitian kuantitatif  

untuk mengetahui korelasi antara prestasi belajar akidah akhlaq dengan 

sikap  tawadhu’ dan sikap ta’awun peserta didik di MTsN 5 Tulungagung.   

Penelitian kuantitatif adalah penelitian yang pada dasarnya 

menggunakan pendekatan deduktif-induktif, artinya pendekatan yang 

berangkat dari suatu kerangka teori, gagasan para ahli, maupun 

pemahaman peneliti berdasarkan pengalamannya, kemudian 

dikembangkan menjadi permasalahan beserta pemecahan yang diajukan 

untuk memperoleh pembenaran (verifikasi) dalam bentuk dukungan data 

empiris di lapangan
1
.   

2. Jenis Penelitian 

Penelitian ini masuk ke dalam penelitian korelatif. Penelitian 

korelatif adalah penelitian yang dilakukan untuk mengetahui tingkat 

korelasi antara 2 variabel atau lebih tanpa memanipulasi 

                                                           
1
 Ahmad Tanzeh, Metodologi Penelitian Praktis, (Jakarta: Teras, 2011), hlm. 63 
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data yang didapat
2
. Dengan demikian, peneliti berusaha mengetahui 

hubungan antara prestasi belajar peserta didik kelas 8 dengan sikap 

tawadhu’ dan sikap ta’awun di MTsN 5 Tulungagung. 

3. Lokasi Penelitian 

Penelitian ini dilakukan di MTsN 5 Tulungagung. Tepatnya 

di Desa Pulosari Kecamatan Ngunut Kabupaten Tulungagung. 

 

B. Variabel Penelitian 

Menurut Suryasubrata, variabel adalah segala sesuatu yang berkaitan 

dengan penelitian atau segala sesuatu sebagai objek penelitian yang 

ditetapkan dan dipelajari sehingga memperoleh informasi untuk menarik 

kesimpulan
3
. Variabel dibedakan menjadi 2 yaitu variabel bebas dan variabel 

terikat.  

1. Variabel Bebas  

Variabel bebas adalah variabel yang mempengaruhi adanya 

perubahan pada variabel terikat. Pada penelitian ini yang menjadi 

variabel bebas (X) adalah prestasi belajar Akidah Akhlaq Peserta didik. 

Indikatornya: Nilai PTS semester genap  mata pelajaran akidah akhlaq 

kelas 8 MTsN 5 Tulungagung 

 

 

                                                           
2
 Suharsimi Arikunto, Prosedur Penelitian : Suatu Pendekatan Praktik, (Jakarta : Rineka 

Cipta, 2010), hlm. 3-4 
3
 Sumardi Suryasubrata, Metodologi Penelitian, (Jakarta: RajaGrafindo Persada, 2006), 

hlm. 25   
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2. Variabel Terikat 

Variabel terikat  adalah variabel yang dipengaruhi oleh variabel 

bebas. Pada penelitian ini variabel terikat (Y) adalah sikap tawadhu’ (Y1) 

dan sikap ta’awun (Y2)  

Indikatornya: 

a. Y1: 

1) Memiliki rasa hormat kepada guru 

2) Memiliki rasa cinta dan kasih sayang kepada guru 

3) Memiliki rasa hormat kepada sesama teman 

4) Memiliki rasa kasih sayang kepada sesama teman 

b. Y2: 

1) Memiliki rasa ikhlas saat menolong guru 

2) Memiliki hubungan yang baik dengan guru 

3) Memiliki rasa ikhlas saat menolong teman 

4) Memiliki hubungan yang baik dengan sesama teman 

 

C. Populasi, Sampel, dan Teknik Sampling 

1. Populasi  

Menurut Ismiyanto, populasi adalah keseluruhan subjek penelitian 

yang dapat berupa orang, benda, suatu yang didalamnya dapat diperoleh 

dan dapat memberikan informasi/data
4
. 

                                                           
4
 Sandu Siyoto, Dasar Metodologi Penelitian, (Yogyakarta: Literasi Media Publishing, 

2015), hlm. 63 
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Jadi, populasi adalah wilayah generalisasi yang terdiri dari objek 

yang memiliki kuantitas dan karakteristik tertentu yang sudah ditetapkan 

oleh peneliti untuk dipelajari lalu disimpulkan. Adapun yang menjadi 

populasi pada penelitian ini adalah peserta didik MTsN 5 Tulungagung. 

Lebih jelasnya populasi digambarkan sebagai berikut: 

Tabel 3.1 

Tabel Populasi Penelitian 

No 

Kelas 

VII 

Jmlh 

Peserta 

didik 

VIII 

Jmlh 

Peserta 

didik 

IX 

Jmlh 

Peserta 

didik 

1. A 29 A 33 A 35 

2. B 27 B 30 B 23 

3. C 37 C 33 C 33 

4. D 33 D 34 D 31 

5. E 35 E 32 E 30 

6. F 31 F 32 F 29 

7. G 33 G 26 G 33 

Total  225 Total 220 Total 214 

Total keseluruhan 659 

 

2. Sampel 

Menurut Sudjana dan Ibrahim, sampel adalah sebagian dari populasi 

yang memiliki sifat yang sama dengan populasi
5
. Sampel yang akan 

diambil dari peserta tersebut harus benar-benar representative atau dapat 

mewakili. Pengambilan sampel, yakni untuk sekedar perkiraan apabila 

subyeknya kurang dari 100, lebih baik diambil semua sehingga 

penelitiannya merupakan penelitian populasi. Selanjutnya jika jumlah 
                                                           

5
 Sandu Siyoto, Dasar Metodologi…. hlm. 64 
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subyeknya besar dapat diambil antara 10-15% atau 20-25% atau lebih, 

tergantung setidak-tidaknya dari: 

a. Kemampuan peneliti dilihat dari waktu, tenaga dan dana. 

b. Sempit luasnya wilayah pengamatan dari setiap 

c. subyek, karena hal ini menyangkut banyak sedikitnya data. 

d. Besar kecilnya resiko yang ditanggung oleh peneliti
6
 

 Populasi pada penelitian ini sebanyak 659 peserta didik, dan  untuk 

menentukan jumlah sampel yang akan di ambil, karena jumlah populasi 

lebih dari 100 orang, maka penarikan sampel dalam penelitian ini 

menggunakan teknik pengambilan sampel menggunakan rumus dari Taro 

Yamane atau Slovin adalah sebagai berikut :  

n = 
 

       
 

Keterangan :  

n = jumlah sampel  

N = (jumlah populasi = 1539 Responden)  

d² = Presisi (ditetapkan 10% dengan tingkat kepercayaan 95 %)  

1 = angka Konstan 

Dengan perhitungan sebagai berikut: 

n = 
 

          
 

n = 
   

              
 

                                                           
6
 Suharsimi Arikunto, Prosedur Penelitian … hlm. 112 
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 = 
   

               
 

 = 
   

     
   = 86, 824 ≈ 87 

Jadi jumlah sampel yang digunakan pada penelitian ini adalah  peserta 

didik jenjang kelas VIII  sebanyak 87 peserta didik di MTsN 5 

Tulungagung. Untuk lebih jelasnya sampel penelitian terdapat dalam tabel 

berikut:  

Tabel 3.2 

Tabel Sampel Penelitian 

No Kelas VIII Jumlah peserta didik 

1. A 13 

2. B 13 

3. C 13 

4. D 12 

5. E 12 

6. F 12 

7. G 12 

Jumlah 87 

 

3. Teknik Sampling  

Teknik sampling adalah cara menata berbagai teknik dan penarikan 

atau pengambilan sampel, dan cara pengambilan sampel agar menjadi 

sampel yang representative. Teknik sampling dibagi menjadi 2 yaitu 

probability sampling (pengambian sampel dengan kesempatan yang sama 

kepada seluruh anggota populasi) dan non-probability sampling 

(pengambilan sampel dengan tidak memberikan kesempatan kepada setiap 

anggota populasi). 
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 Pada penelitian ini, teknik sampling yang digunakan adalah 

probability sampling tipe “cluster sampling". Teknik tersebut adalah 

pengambilan sampel bila populasi penelitian sangat luas. Dengan 

menentukan sampel daerah lalu menentukan anggota yang ada dalam 

sampel tersebut. 

Populasi pada penelitian ini sebanyak 659 peserta didik yang terbagi 

ke dalam 7 kelas pada jenjang kelas VII, 7 kelas pada jenjang kelas VIII, 

dan 7 kelas pada jenjang kelas IX. Karena jumlah populasi lebih dari 100, 

maka penentuan sampel harus menggunakan perhitungan rumus Slovin. 

Setelah perhitungan yang dilakukan diatas, maka dapat diambil sampel 

sebanyak 87 peserta didik.  Pengambilan sampel dilakukan dengan 

memilih 12 sampai 13 peserta didik dikelas VIII A sampai G , sehingga 

jumlah sampel sebanyak 87 peserta didik.   

 

A. Kisi-Kisi Instrumen 

Pada penelitian ini menggunakan angket dalam mendapatkan data. 

Adapun kisi-kisi angket yang digunakan sebagai berikut: 

Tabel 3.3 

Tabel Kisi-Kisi Angket Tawadhu’ 

No Variabel Aspek Indikator 

No item 
Jmlh 

item Favorable 
Unfavor

able 

1. Prestasi 

Belajar 
 Nilai PTS 

kelas VIII 

semester 

genap 
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2. Sikap 

Tawadhu’ 
7
 

Sikap 

tawadhu’ 

kepada 

guru 

a. Memiliki 

rasa 

hormat 

kepada 

guru 

1,3 2,4 4 

   b. memiliki 

rasa cinta 

dan kasih 

sayang 

kepada 

guru 

5,7 6,8 4 

  Sikap 

tawadhu’ 

kepada 

sesama 

teman 

a. Memiliki 

rasa 

hormat 

kepada 

teman 

9, 11 10, 12 4 

   b. memiliki 

rasa cinta 

dan kasih 

sayang 

kepada 

teman 

13,15 14,16 4 

Jumlah 8 8 16 

 

Tabel 3.4 

Tabel Kisi-Kisi Angket Ta’awun 

No Variabel Aspek Indikator 

No item 
Jmlh 

item Favorable 
Unfavora

ble 

3. Sikap 

Ta’awun 
8
 

Sikap 

ta’awun 

kepada 

guru 

a. memiliki 

rasa 

ikhlas 

saat 

menolon

g guru 

17, 19 18, 20 4 

   b. memiliki 

hubunga

n yang 

baik 

dengan 

guru 

21, 23 22, 24 4 

  Sikap 

ta’awun 

kepada 

a. memiliki 

rasa 

ikhlas 

25, 27 26, 28 4 

                                                           
7
 Aliy As’ad, Terjemah Ta‟limul .... hlm. 20 

8
 Ibid,. 37 
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sesama 

teman 

saat 

menolon

g teman 

   b. memiliki 

hubunga

n yang 

baik 

dengan 

teman 

29, 31 30, 32 4 

Jumlah 8 8 16 

 

E. Instrument Penelitian 

Instrumen penelitian adalah alat ukur yang digunakan peneliti untuk 

mendapatkan informasi kuantitatif tentang variabel yang berkarakter dan 

objektif
9
. Adapun instrument yang digunakan pada penelitian ini adalah: 

1.  Angket 

  Angket adalah daftar pertanyaan yang harus diisi oleh orang yang 

akan diukur (responden) dengan tujuan memeroleh data yang 

dibutuhkan
10

. Angket dibagi menjadi 2, yaitu angket terbuka dan angket 

tertutup. Angket terbuka adalah angket dimana responden dapat 

menjawab sesuka hati responden . Sedangkan angket tertutup adalah 

angket yang jawabannya dibatasi/ responden tinggal memiliki opsi 

jawaban yang sudah disediakan.  

Angket dalam penelitian ini dianalisis dengan menggunakan teknik 

analisis statistik yang menghitung nilai kualitas dan kuantitas dengan 

cara memberikan penilaian berdasarkan atas jawaban angket yang telah 

disebarkan kepada responden, dimana masing-masing item diberikan 

                                                           
9
. Nurul Zuriah, Metodologi Penelitian Sosil dan Pendidikan, (Jakarta: PT Bumi Aksara, 

2009) hlm. 166  
10

 Ajat Rukajat, Teknik Evaluasi Pembelajaran, (Yogyakarta: Depublish, 2018), hlm. 55 
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pilihan jawaban. Kriteria pemberian skor meliputi 4 item untuk 

pernyataan positif dan 4 item untuk pernyataan negatif sebagai berikut: 

  Tabel 3.5 

   Tabel Kriteria Pemberian Skor Angket Positif  

Jawaban Peryataan Positif  Skor  

Selalu 4 

Sering 3 

Kadang-kadang 2 

Tidak Pernah 1 

 

  Tabel 3.6 

   Tabel Kriteria Pemberian Skor Angket Negatif 

Jawaban Peryataan Negatif  Skor  

Selalu 1 

Sering 2 

Kadang-kadang 3 

Tidak Pernah 4 

 

Angket yang digunakan dalam penelitian ini menggunakan media 

google form karena dalam proses penyebaran angket melalui jaringan 

google classroom kelas responden. Adapun angket yang disebar terdapat 

pada link: https://forms.gle/k2rhawf1ga9vbrDh6  

Sebelum instrumen disebarkan kepada responden, langkah awal 

yang dilakukan adalah melakukan uji coba nstrumen. Uji coba ini 

dilakukan untuk mengetahui kualitas dari instrumen. Adapun alat yang 

digunakan dalam pengujian analisis uji coba instrumen meliputi uji 

validitas dan uji reliabilitas angket. 

 

https://forms.gle/k2rhawf1ga9vbrDh6
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a. Uji Validitas 

Dalam penelitian ini digunakan metode pengujian validitas isi 

yang dapat dilakukan dengan melihat korelasi antara butir dengan 

total.  Suatu instrumen itu dapat mengungkap data dari variabel yang 

dikaji secara tepat bila instrumen tersebut teruji kevalidan setelah 

dilakukan uji validitas. Dalam perhitungan uji validitas, digunakan 

rumus korelasi yang dikemukakan oleh Pearson, yang dikenal dengan 

rumus Korelasi Product Moment, yakni sebagai berikut:  

rxy = 
               

√{             }{             }
 

Keterangan:  

rxy = Koefisien korelasi antara X dan Y 

X = Skor faktor yang dimiliki oleh testee yang dijawab benar 

Y = Skor total 

N = Jumlah testee 

Kriteria: 

r hasil > r tabel = valid 

r hasil < r tabel = invalid 

Untuk menghitung validitas item soal digunakan perhitungan 

statistik korelasi Product Moment yaitu dengan menggunakan SPSS 

(Statistical Product and Service Solution) 16.0 for Window.Berikut 

adalah langkah-langkah pengujian valilditas dengan SPSS adalah:  

1) Aktifkan program SPSS → klik Variabel View, definisikan data 

→ klik data view, masukkan data  
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2) Klik Analyze → Correlate → Bivariate  

3) Masukkan semua item ke kotak variabel → klik Ok  

b. Uji Reliabilitas 

Uji reliabilitas adalah indeks yang menunjukkan sejauh mana 

suatu alat pengukur dipakai dua kali untuk mengukur gejala yang 

sama dan hasil pengukuran yang diperoleh relatif konsisten, maka alat 

pengukur tersebut disebut reliabel. Dengan kata lain, reliabilitas 

menunjukkan konsistensi suatu alat pengukur didalam mengukur 

gejala yang sama. Untuk mengetahui reliabilitas angket dapat 

digunakan rumus Crombach’s Alpha sebagai berikut: 

r11 = [
 

   
] [  

   

   
] 

Keterangan : 

N = banyaknya butir soal 

Si
2
 = jumlah varians skor tiap item 

St
2
 = varians skor total 

Kriteria: 

Jika rhitung > rtabel maka tes tersebut reliabel 

Jika rhitung < rtabel maka tes tersebut tidak variabel  

Berikut adalah langkah-langkah pengujian reliabilitas dengan 

SPSS:  

1) Aktifkan program SPSS → klik Variabel View, definisikan data → 

klik data view, masukkan data  

2) Klik Analyze → Scale → Reliability Analysis  



65 
 

 
 

3) Masukan semua variabel ke dalam kotak item → pilih formula 

Alpha → klik Ok  

 

F.  Sumber Data 

Sumber data adalah subjek dimana data tersebut diperoleh
11

.  Sumber 

data ialah semua informasi baik dari benda  nyata maupun abstrak, peristiwa 

baik secara kualitatif maupun kuantitatif
12

. Sumber data ada 2, yaitu sumber 

data primer dan data sekunder.  

1.  Data Primer  

Data primer adalah data yang diperoleh atau dikumpulkan langsung 

dilapangan oleh orang yang melakukan penelitian
13

. pada penelitian ini 

sumber data yang digunakan adalah data angket. 

2.  Data sekunder  

Data sekunder adalah data yang dikumpulkan oleh peneliti 

berdasarkan data yang telah ada
14

. Pada penelitian ini sumber data 

sekunder yang digunakan adalah data raport sisipan peserta didik kelas 

VIII. 

 

 

 

                                                           
11

  Suharsimi  Arikunto , Prosedur Penelitian …. hlm. 174 
12

 Jalaludin Rahmad, Metodologi Penelitian, (Yogyakarta: Gajah Mada University Press, 

2012), hlm. 44 
13

 Iqbal hasan, Analisis Data Penelitian Dengan Statistik, ( Jakarta: Bumi aksara, 2006), 

hlm. 19 
14

 Ibid.., hlm. 20 
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G.  Teknik Pengumpulan Data 

Pengumpulan data adalah prosedur yang sistematik dan standar untuk 

memperoleh data yang diperlukan
15

. Adapun teknik pengumpulan data pada 

penelitian ini adalah: 

1. Metode Angket (Kuesioner)  

Metode angket atau kuesioner adalah suatu daftar yang berisikan 

rangkaian pertanyaan mengenai sesuatu masalah atau bidang yang akan 

diteliti. Untuk memperoleh data, angket disebarkan kepada responden 

(orang-orang yang menjawab atas pertanyaan yg diajukan untuk 

kepentingan penelitian), terutama pada penelitian survey
16

. Dalam 

penelitian ini, peneliti menggunakan angket tertutup untuk mengetahui 

tingkat tawadhu’dan ta’awun peserta didik. 

2. Metode Dokumenter  

Metode dokumenter adalah alat pengumpulan datanya disebut form 

pencatatan dokumen, dan sumber datanya berupa catatan atau dokumen 

yang tersedia. Seperti halnya kehadiran peserta didik dalam mengikuti 

acara-acara pelajaran dikelas, dokumennya terlihat pada daftar hadir 

peserta didik
17

. Dalam penelitian ini, peneliti menggunakan data nilai 

rapot sisipan peserta didik untuk mengetahui prestasi belajar peserta 

didik kelas VIII. 

 
                                                           

15
 Ahmad Tanzeh, Pengantar Metode …, hal. 57 

16
 Cholid Narbuko, Ahmadi, Metodologi Penelitian, (Jakarta: Bumi Aksara, 2010), hal. 

76.  
17

 Sanapiah Faisal, Format-format Penelitian Sosial, (Jakarta: Raja Grafindo, 2007), hal. 
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H. Teknik Analisis Data 

Teknik analisis data adalah Analisis data yang penulis gunakan pada 

penelitian ini menggunakan analisis kuantitatif. Teknik analisis data dalam 

penelitian kuantitatif menggunakan statistic
18

. 

1. Uji Normalitas  

Uji normalitas data digunakan untuk mengetahui apakah data akhir 

kelas sampel berdistribusi normal atau tidak. Untuk menguji normalitas 

data dapat menggunakan uji Kolmogorov–Smirnov.Dalam penelitian ini uji 

normalitas data dilakukan dengan bantuan SPSS (Statistical Product and 

Service Solution) 16.0 for Window. Kriteria pengujian normalitas dengan 

SPSS dikatakan normal apabila Asymp.sig (2–tailed) > 0,05. Langkah-

langkah pengujian normalitas dengan SPSS adalah sebagai berikut:  

a. Aktifkan program SPSS → buat data pada Variabel View  

b. Masukkan data dalam SPSS  

c. Klik Analyze → pilih Nonparametric Test→ pilih 1-Sampel K-S → 

klik Ok  

2. Uji Linearitas 

Uji linieritas ini bertujuan untuk mengetahui apakah dua variabel 

mempunyai hubungan yang linier atau tidak secara signifikan. Hubungan 

yang linier menggambarkan bahwa perubahan pada variabel prediktor 

akan cenderung diikuti oleh perubahan pada variabel kriterium dengan 

                                                           
18

 Sugiono, Metode Penelitian… hlm. 207 
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membentuk garis linier. Langkah-langkah pengujian linearitas dengan 

SPSS adalah sebagai berikut:  

a. Aktifkan program SPSS → buat data pada Variabel View  

b. Masukkan data dalam SPSS  

c. Klik Analyze Compare Means→ means 

d. Masukan data sesuai tempat variabel → klik options → centang test for 

linearlity 

e. Klik Continue 

3. Uji MANOVA  

Manova adalah uji statistik yang digunakan untuk mengukur 

pengaruh variabel independen yang berskala kategorik terhadap beberapa 

variabel dependen sekaligus yang berskala data kuantitatif. Analisis ini 

disebut juga dengan istilah multivariat anova. Untuk mencari hasil dari 

rumusan masalah 1  sampai 3 maka digunakan Uji MANOVA, karena 

untuk mengetahui hubungan antara X dengan Y1, X dengan Y2, maupun 

X dengan Y1 dan Y2. Adapun langkah-langkah pengujian MANOVA 

dengan SPSS adalah sebagai berikut:  

a. Aktifkan program SPSS → buat data pada Variabel View  

b.  Masukkan data dalam SPSS  

c. Klik klik Analyze→ General Linear Model→ Multivariate   → 

masukkan variabel dalam kotak yang sesuai 
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d. Klik Tombol Model → bisa menggunakan nilai bawaan (default) yaitu 

Full Factorial atau custom, jika memilih Custom maka mengubah Type 

ke Main Effects → Klik Continue 

e. Klik Tombol Post Hoc → masukkan variabel yang sesuai ke kotak Post 

Hoc Test For, pada Equal Variances Assumed centang Bonferroni 

dan pada Equal Variances Not Assumed centang Games-Howell.  

f. Klik Continue  → tombol options. Lalu masukkan variabel yang sesuai 

ke dalam kotak Display Means for. Pada display, centang Descriptive 

Statistics, Observed Power dan Homogenty Tests. Dan biarkan 

Significance Level 0,05. 

g. Klik Continue 

 

 

 

 

 

 

 

 

 

 


